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1 Introduction
What is LogWare?

1.1

1.2

1.3

Introduction

What is LogWare?

Hart’s 9934 LogWare is a real-time data logging, storage and analysis software
program designed specifically for use with Hart Scientific digital thermometers.
LogWare automates the logging of data from a single channel or input.

LogWare is designed to work with the following Hart Scientific digital
thermometers:

e 1502 Thermometer Readout (2 styles)

e 1502A Thermometer Readout

e 1503 Thermometer Readout

e 1504 Thermometer Readout

e 1521 Handheld Thermometer Readout

e 1522 LLL Handheld Thermometer Readout and Datalogger

License Agreement

For information and details regarding the software End User License Agree-
ment (EULA), refer to the online help file’s License Agreement topic

Features

LogWare provides an easy-to-use Windows® interface to log, store and analyze
data from Hart Scientific digital thermometers. LogWare also provides a
method to download readings that are stored in the memory of thermometers
that support this feature, such as the model 1522 LLL Handheld Datalogger.
After being logged or downloaded, the readings are written to a file that can be
opened by LogWare, spreadsheet or other analysis software.

LogWare’s data logging features include:

e Quick and easy configuration

e Ability to save and open setup configuration files

e Selectable sample interval from 1 second to 24 hours

e Selectable delayed start time/date for off-hours logging

e Selectable end log options (allows a log session to stop automatically af-
ter a specified time or a specified number of readings)

e Logs readings to ASCII text files that can then be opened, graphed and
printed

e Graphs readings as they are being logged

e Maintains statistical data for logged readings
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e Ability to set High and Low alarms

e Can play .WAV file or launch any other software package when an alarm
trips (such as Pager software)

e Many user-customizable graph settings including alarm, statistical and
trend lines

LogWare’s data analysis features include:

e Can open both real-time log files and downloaded files
e Spreadsheet-style grid to view all readings

e Graph that displays up to 32,767 readings at a time

e Graph zooming capability

e Statistical lines and calculations

e Printing graph and readings

e Can have multiple windows open simultaneously

LogWare also provides utilities which allow access to the following thermome-
ter features (as applicable):

e Download logged data

e View log status

e Change log labels

e Synchronize date/time with computer

e Change thermometer-specific parameters (filter, resolution, units, calibra-
tion dates and constants, etc.)

e Change INFO-CON or probe-specific parameters (conversion type and
coefficients, calibration dates, excitation current, etc.)
Version 1.3
A list of new features and enhancements in this software follows:

¢ Branding/Logo change — The logos and graphics displayed in LogWare
have been updated.

Also, various features have been added to the software to aid in troubleshooting
issues related to downloading logged data

1.4 Requirements

LogWare supports the Hart Scientific digital thermometer models as listed be-
low. The communication and computer requirements are also listed.

1.4.1 Thermometer readout requirements

LogWare is designed to work with the following Hart Scientific digital ther-
mometer readouts:
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1.4.2

1.4.3

1.4.4

e 1502 Thermometer Readout (2 styles)

e 1502A Thermometer Readout

e 1503 Thermometer Readout

e 1504 Thermometer Readout

e 1521 Handheld Thermometer Readout

e 1522 Handheld Thermometer Readout and Datalogger

Communications requirements

The instrument being used with LogWare must be connected to a COM
(RS-232 serial) port on a computer using a “null modem” cable. (A “null mo-
dem” cable is a cable that effectively replaces two modems. Refer to the ther-
mometer’s User Guide for more information on the cable or contact hart
Scientific Customer Service to purchase a “null modem” cable.) The baud rate
can be set from 300 baud to 9600 baud depending on the instrument. However,
the instrument and computer baud rates must match.

Computer hardware requirements
The following minimum computer configuration is required to use LogWare.

e IBM Compatible 486 PC or better with S8MB RAM (Pentium® class pro-
cessor with 16MB RAM or more recommended)

e VGA monitor or better
e CD-ROM drive for installation
e [ —RS-232 (COM) port)

e Minimum of about 8MB of disk space (for installation) - The program re-
quires additional disk space to store the data as it is acquired.

Computer software requirements

Note: To use LogWare, Windows® login accounts must be granted full ac-
cess to the folder to which the software is installed and all subfolders. If
the folder has read-only access, errors will occur when LogWare attempts
to access its configuration files.

LogWare requires one of the following operating systems

o Windows® 95/98
e Windows® NT with SP4/2000/XP

Note: LogWare has only been tested on Windows® NT with Service Pack
4 installed.
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1.5 Installation

A Note: Before installing LogWare, be sure to read the License Agreement
and Warranty.

A backup should always be made of your hard disk drive and registry before in-
stalling any software, and all running applications should be closed.

A Note: To successfully install LogWare, you must be logged into Windows
as an Administrator.

Installing LogWare

1. Insert the LogWare CD-ROM into your CD-ROM drive. The Setup pro-
gram should run automatically.

2. Follow the on-screen instructions to install LogWare.

When prompted, enter the product serial number. The serial number is
provided on a sticker typically located on the CD pouch on the inside
back cover of the LogWare User’s Guide.

4. After all files have been installed, a program group is created with icons
for the software, the Help file, the README.TXT file, and an icon to
uninstall the software. The installation process is complete.

5. The README.TXT file can be displayed by checking the appropriate
check box before the setup program finishes. Read this file for important
information that was not available when the User Guide was printed.

Uninstalling LogWare

To uninstall the software, use the Windows® Add/Remove Programs icon in
the Control Panel. Follow the instructions given. The program files that were
installed to your system are removed. Any files that were created or saved by
users will not be removed from the system. These files, along with the folders
that these files are in, must be manually deleted using Windows® Explorer to
remove them from your system.

1.6 Regional settings

LogWare recognizes and uses the regional settings such as the date, time and
number formats as set in the Windows® Control Panel’s Regional Settings or
Regional Options icon.

1.7 Running LogWare

The following sections describe how to get LogWare up and running quickly.
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1.7.1

Getting started

The following information is intended to provide a brief overview on how to
get LogWare up and running quickly. For more detailed information, please re-
fer to the following sections:

e Section 1.8, LogWare Main Display
e Section 4, Datalog Menu

To use this software:

1. Click the Start button, then locate and click the icon created by the setup
process.

2. The software will start with the Log Session Settings dialog displayed on
top of the main display (see Section 4.1). If the Log Session Settings dia-
log is not displayed when the software starts, select the Setup option
from the Datalog menu.

Note: In order to make the Log Session Settings dialog appear when the
software starts, check the “Show Log Session Settings dialog on start-up”
check box on the General tab of the Defaults dialog.

To start a log session, fill in the information on the Log Session Settings dialog.
The following information must be entered before a log session can start:

e Select the Model of the thermometer to use. Enter the Serial Number and
select the Readings Scale from the available choices.

e Select the COM port to which the thermometer is connected and choose
the baud rate.

e Power up the thermometer and make sure it is connected to the specified
COM port. Click the Test Communication button to make sure LogWare
can communicate with the thermometer.

e Choose the log interval (time between readings)

e Choose the appropriate end log option and set the other end log settings
as required.

e To set a delayed start date/time, click the Delayed Start button and choose
the appropriate date and time for the log session to begin. Otherwise, the
log session will begin when the Start button is clicked.

e Select the trace color, enter the output filename and set the statistics op-
tions as desired.

e To configure alarms, click the Alarm Settings button and set the appropri-
ate alarm settings as desired.

These settings can be saved to a configuration file by clicking the Save As but-
ton. If this configuration should be opened every time the software runs, click
the Set as Default button.
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After entering this information, click the Start button to start the log session.

1.8 LogWare main display

The main display (Figure 1) consists of the menu bar, toolbar, a workspace area
and a status bar.

2 ogware =T

File Datalog Download View Graph Tools Window Help
| B

DEd [ i ag [Eaa (Qa¥e

Ready 8/12/2005 323 PM .

Figure 1 9934 LogWare main display

The menu bar allows access to the various features of the software. A general
description of the options in each menu is given below:

¢ File — Open and save configuration files, change default settings, printing
options, exit the software
e Datalog — Setup, Start, Stop and Close real-time log sessions

¢ Download — Download logged readings from a thermometer and view log
status

e View — View alarm log and reading history during real-time log session
and open previously logged data files
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e Graph — Change graph settings, zoom in and out, and print the current
graph

e Tools — Synchronize thermometer date/time, configure various thermome-
ter and INFO-CON/probe settings

e Window — Rearrange and switch between open windows
e Help — Display help topics and About dialog

The toolbar allows quick access to the most common menu functions. The
toolbar is divided into sections that correspond to related functions. Toolbar
sections may be rearranged as desired by clicking on the vertical bar on the left
side of the section and dragging it to the desired location.

The status bar indicates the function that the software is currently performing
as well as the current system date and time.

Note: The date and time displayed are based on the computer’s clock set-
tings and can be modified through the Windows® Control Panel. The date
and time formats used can be changed by selecting the Regional Settings
icon in the Control Panel.

Toolbar

The toolbar (Figure 2) provides quick access to many of the most common
functions of the software. The toolbar is divided into sections that correspond
to related menu options. Toolbar sections may be rearranged as desired by
clicking on the vertical bar on the left side of the section and dragging it to the
desired location.

D= E

[ Fr 1 A¢ | WA [Ss®e [

Figure 2 LogWare toolbar

1.9.1

The following toolbars are available:

File toolbar

D2 | |

Figure 3 File toolbar

New — Create a new real-time log session configuration
Open — Open a real-time log session configuration file

Save As — Save the current real-time log session settings to a configuration file
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1.9.2 Datalog toolbar

Zr n ARG

Figure 4 Datalog toolbar

Setup — Setup a real-time log session
Start — Start a real-time log session
Stop — Stop a real-time log session
Close — Close a real-time log session

Mute all alarms — Mute/Unmute all real-time log session alarms

1.9.3 Graph toolbar

Figure 5 Graph toolbar

Graph settings — Change graph settings, add trend lines, alarm lines, titles,
captions, etc.

Zoom in — Zoom in to view a section of the graph

Restore (zoom out) — Zoom out to view entire graph

194 Tools toolbar

S @

Figure 6 Tools toolbar

Synchronize date/time — Synchronize thermometer’s date/time with computer
Write labels — Change the labels associated with datalogging

INFO-CON/probe settings — Change settings associated with the INFO-CON
connector or probe

Thermometer settings — Change settings associated with the thermometer
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1.95 Help toolbar

1% |

Figure 7 Help toolbar

Help — Open the help file
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Using an I/R dongle with LogWare

2

2.1

How to...

This section contains some “How to...” step-by-step instructions and other in-
formation on how to use LogWare to perform certain tasks. The following top-
ics are included:

Using an I/R dongle with LogWare (see Section 2.1).
Opening a configuration file automatically on start-up (see Section 2.2).

Starting a real-time log session unattended (Delayed Start) (see Section
2.3).

Stopping a real-time log session automatically (see Section 2.4).

Downloading logged data from the memory of a thermometer (see Sec-
tion 2.5).

Viewing remaining memory for logging data (see Section 2.6).

Changing thermometer and/or INFO-CON/probe settings (see Section
2.7).

Saving thermometer and/or INFO-CON/probe settings to a configuration
file (see Section 2.8).

Synchronizing the thermometer’s clock to the computer (see Section 2.9).

Importing logged data into a spreadsheet (see Section 2.10).

Using an I/R dongle with LogWare

Some Hart Scientific thermometer readouts, such as the 1522, have a built-in
I/R port that can be used to communicate with a computer. I/R ports have many
advantages over standard RS-232 ports which include increased data transfer
rate, greater flexibility and ease of use.

Hart thermometer readoutss with an I/R port use a proprietary protocol for
communication. Because of this proprietary protocol, LogWare is not able to
use I/R ports that are built into a computer. Instead, LogWare requires the use
of an I/R dongle (Figure 8) which can be connected to a standard RS-232 port.
No special software or drivers are required to use the dongle. All necessary

11
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communication protocols and drivers are built into LogWare. To purchase an
I/R dongle (model 2374), contact technical support.

Figure 8 Model 2374 Infrared Dongle

LogWare provides support for communicating over an I/R port with these ther-
mometers. However, the support is limited to the following features:

e Downloading logged data from memory

e Checking log status

e Writing labels associated with logged data
LogWare does not support using the I/R port for real-time log sessions.
To use an I/R dongle with LogWare, follow these steps.

1. Locate a 9-pin or 25-pin COM (RS-232) port on the computer. Connect
the I/R dongle to the port. If the COM port is a 25-pin port, use a 9-25
pin adapter to connect the dongle.

2. In the Download menu, select either the Download Logged Data option
or the Log Status option. Or, in the Tools menu, select the Write labels
option. The Select Model dialog is displayed (see Section 8.5).

3. Select the thermometer model to use. Then select the COM port to which
the I/R dongle is connected.

- 111
A Note: In the COM port drop down list, ports with the symbol = rep-
resent built-in I/R ports and cannot be used!!

12
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2.2

4. Next, check the Use I/R Dongle check box. When this box is checked,
the Baud Rate setting is ignored since the thermometers are fixed at
115,200 baud when using the I/R port.

5. To ensure the computer can communicate with the thermometer using
the I/R port, place the I/R window of the thermometer in close proximity
to the I/R dongle and make sure the path between the two is not ob-
structed (see the thermometer’s User Guide for details on the proximity
requirements). Click the Test Communication button. If LogWare suc-
ceeds in communicating with the thermometer a success message is dis-
played. Otherwise, a failure message is displayed. In case of failure,
check the following:

The dongle is connected to the selected COM port

e The thermometer is powered up and operating

e The dongle is in range of the I/R port on the thermometer

e The path between the thermometer and dongle is not obstructed

e Shut the thermometer’s power off, then back on again

When communication succeeds, click the OK button to proceed to the appro-
priate dialog.

Opening a configuration file automatically on
start-up

LogWare was designed to be flexible with the thermometers that it can use and
the features it supports. However, most users of LogWare will probably always
use the same thermometer, scale, communication settings, log interval and
channel and alarm settings to do all or most of their logging.

For this reason, LogWare allows real-time log session settings to be saved to a
configuration file. Opening the configuration file restores the settings eliminat-
ing the need to manually enter most of the information for a new log session.

Configuration files save the following information about a real-time log
session:

e Thermometer model, serial number and readings scale
e Communications COM port and baud rate

e Loginterval and End Log settings

e Channel trace color and filename

e Alarm and statistics settings

The delayed start date and time information is not saved in the configuration
file. For more information on configuration files, please read Configuration
Files.
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In addition to allowing configuration files to be saved and opened, LogWare
also allows one configuration file to be opened automatically every time
LogWare runs. This configuration file can be specified in one of two ways:

e From the Defaults dialog (see Section 3.4.1)
e From the Log Session Settings dialog (see Section 4.1)

Opening configuration file automatically using the Defaults dialog:

e Select the Defaults option from the File menu (see Section 3.4.1).

e Select the General tab.

e Check the Show Log Session Settings dialog on start-up check box.
e Check the Load default configuration file automatically check box.

e Click the “...” (Browse) button to select the configuration file to open or
type the path and filename in the Default configuration file box.

e Click the OK button to save the changes.

Note: The real-time log session settings must already be saved to a config-
uration file in order to accomplish these steps.

Opening configuration file automatically using the Log Session Settings
dialog:

e Select the Setup option from the Datalog menu (see Section 4.1).

e Fill in all of the information on this dialog.

e Click the Alarm Settings button and fill in the desired alarm settings.

e Click the Set as Default button.

e A prompt is displayed to save the settings to a configuration file. Enter the
filename for this configuration file (use a descriptive name).

e A prompt is displayed to confirm setting this configuration as the default
configuration file. Click Yes.

e Click the Close button to close the dialog.

Test this feature to make sure it works properly by closing LogWare and run-
ning it again. The Log Session Settings dialog should be displayed with all of
the configuration information filled in. If the configuration file is not being
loaded, check the Defaults dialog as explained above.

To disable opening the configuration file on start-up, uncheck the Load default
configuration file automatically check box on the Defaults dialog.
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Starting a real-time log session unattended
(delayed start)

The main purpose of LogWare is to log data in real-time. Many times, the tech-
nician is present when a log session starts. However, sometimes it is necessary
or desirable to start a real-time log session at off-hours when the technician is
out.

LogWare has a feature called the Delayed Start which allows a real-time log
session to start at a predefined date and time. By default, a real-time log session
starts immediately when the Start button on the Log Session Settings dialog is
clicked or when the Start option in the Datalog menu is selected.

Setting the delayed start date and time for a real-time log session:
e Select the Setup option from the Datalog menu to display the Log Session
Settings dialog (see Section 4.1).

e Fill in the Thermometer settings and Communication settings informa-
tion.

e Set the Log interval and choose the appropriate End Log settings.
e Click the Delayed Start button to display the Delayed Start Date/Time di-
alog.

e Choose the date and time that the real-time log session should start. The
start date and time are with respect to the computer’s clock settings. Make
sure the computer’s clock is accurate. Click the OK button to accept the
selected date and time.

Note: To cause the real-time log session to start immediately when click-
ing the Start button after having set a delayed start date and time, click the
Reset button.

e Fill in the Channels information to complete the setup process.
e Click the Start button on the Log Session Settings dialog.

e LogWare displays a message indicating the date and time the real-time log
session will start.

e To cancel the delayed start, click the Cancel button at any time.

After a real-time log session ends, the delayed start time is reset so that the next
real-time log session will start immediately when the Start button on the Log
Session Settings dialog is clicked or when the Start option in the Datalog menu
is selected. To set a new delayed start time for the next real-time log session,
follow the steps above.
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A Note: Every effort has been made to make the real-time log session take
its first reading at the selected date and time. However, due to the large
variation in the speed at which different computers operate, the first read-
ing may be one or more seconds later than the selected time (commonly
known as “latency”). To compensate for this, try a few tests to determine
the approximate latency in the computer being used and then adjust the
start time accordingly by reducing the start time by the difference between
the selected start time and the actual time of the first reading.

24 Stopping a real-time log session automatically

The main purpose of LogWare is to log data in real-time. Many times, the tech-
nician is present when a log session needs to be stopped. However, sometimes
it is necessary or desirable to stop a real-time log session when the technician is
busy with another task, or at off-hours when the technician is out.

The End Log feature of LogWare provides three methods for stopping a
real-time log session:

e Manually, by the technician

e Automatically, after a specific number of readings

e Automatically, after a specific period of time
The first method, Manually, by the technician, is the default End Log setting.
Stopping the real-time session automatically:

e Select the Setup option from the Datalog menu to display the Log Session
Settings dialog (see Section 4.1).

e Fill in the Thermometer settings and Communication settings informa-
tion.

e Set the Log interval.
e If needed, select the appropriate delayed start date and time.

e Using the End Log drop down list, select the method to use to stop the
real-time log session:

By user — Log session stops when the Stop option in the Datalog menu is
selected

After specified # of readings — Log session stops automatically when number
of readings specified have been logged

After specified time — Log session stops automatically after the specified time
has elapsed

e Specify the End Log criteria by selecting either the number of readings or
the elapsed time

e Fill in the Channels information to complete the setup process.

16



thermometer

2 How to...
Downloading logged data from the memory of a

2.5

2.6

e Click the Start button on the Log Session Settings dialog to start the
real-time log session.

Downloading logged data from the memory of a
thermometer

Some thermometers that are supported by LogWare allow readings to be logged
to the memory of the thermometer. LogWare provides a feature to download the
logged readings from the memory of the thermometer and save them to a text
file (or files) on the computer.

Currently, only the Model 1522 LLL Handheld Datalogger has this capability.

Downloading readings from the memory of a thermometer to a text file (or
files) on the computer:

e Select Download Logged Data from the Download menu (see Section
5.1).

e The Select Model dialog is displayed (see Section 8.5). Select the ther-
mometer model from which the readings are to be downloaded. Also, se-
lect the COM port to which the thermometer is connected and the baud
rate to use. If using the I/R port, check the Use I/R Dongle check box.

A Note: The 1522 LLL Handheld Datalogger has an I/R port which can be

used to download readings. Using the I/R port requires an I/R dongle to
be connected to a COM port on the computer. For more information,
please read Section 2.1 Using an I/R dongle with LogWare.

e Make sure LogWare can communicate with the thermometer by clicking
the Test Communication button.

e (lick the OK button when communication is successful.

e The Download dialog is displayed. This dialog is specific to the options
and features of the selected thermometer model.

e Select the appropriate download options and click the Download button to
download the readings.

e Click the Close button to close the Download dialog when finished.

Viewing remaining memory for logging data

Some thermometers that are supported by LogWare allow readings to be logged
to the memory of the thermometer. LogWare provides a feature that indicates
how much of the thermometer’s memory is already used.

Currently, only the Model 1522 LLL Handheld Datalogger has this capability.

Viewing the status of the thermometer’s log(s):
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e Select Log Status from the Download menu (see Section 5.2).

e The Select Model dialog is displayed (see Section 8.5). Select the ther-
mometer model from which the readings are to be downloaded. Also, se-
lect the COM port to which the thermometer is connected and the baud
rate to use. If using the I/R port, check the Use I/R Dongle check box.

Note: The 1522 LLL Handheld Datalogger has an I/R port which can be
used to download readings. Using the I/R port requires an I/R dongle to
be connected to a COM port on the computer. For more information,
please read Section 2.1 Using an I/R dongle with LogWare.

e Make sure LogWare can communicate with the thermometer by clicking
the Test Communication button.

e (Click the OK button when communication is successful.

e The Log Status dialog is displayed indicating how much of the thermome-
ter’s memory is already used. This dialog is specific to the features of the
selected thermometer model.

e Click the Close button to close the Log Status dialog when finished.

2.7 Changing thermometer and/or INFO-CON/probe
settings

LogWare provides a feature which allows many of the thermometer and
INFO-CON/probe settings to be read in, viewed, modified and written back out
to the thermometer. These settings include:

e Filter

e Resolution

e Thermometer calibration and recalibration dates
e Thermometer calibration constants

e Probe serial number

e Probe wires

e Probe calibration and recalibration dates

e Probe conversion type and calibration coefficients
Viewing, modifying and writing the new settings to the thermometer:

e Select Thermometer Settings from the Tools menu (see Section 8.4).

e The Select Model dialog is displayed (see Section 8.5). Select the ther-
mometer model from which the settings are to be read in. Also, select the
COM port to which the thermometer is connected and the baud rate to
use.

18
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e Make sure LogWare can communicate with the thermometer by clicking
the Test Communication button.

e (lick the OK button when communication is successful.

e All thermometer and INFO-CON/probe settings are then read in and dis-
played in the Thermometer Settings dialog.

A Note: The controls for settings which do not apply to the selected ther-
mometer are disabled.

e Any of the settings can be modified at this time. All passcode protected
settings are indicated in RED. These settings can be modified freely but
will not be written back to the thermometer without the correct passcode
being entered when prompted.

e To view or modify the INFO-CON/probe settings, select the appropriate
channel from the Channels list and click the Channel Settings button to
display the Channel Settings dialog.

e All thermometer and INFO-CON/probe settings can be saved to a config-
uration file by clicking the Save As button. To read in a configuration file
containing thermometer and INFO-CON/probe settings, click the Open
button. Thermometer configuration files have a .THM extension.

Note: Thermometer configuration files are specific to each thermometer
model. LogWare does not allow a thermometer configuration file for a
1502 to be opened when working with a 1521, etc. Therefore, when saving
thermometer configuration files, include the thermometer model number
in the filename so that the contents of the file are known.

e To write any changes that have been made back out to the thermometer,
click the OK button. If any of the passcode protected settings were
changed, the Enter Passcode dialog is displayed (see Section 8.6). The
correct passcode MUST be entered in order for the new settings to be
properly written to the thermometer.

Note: LogWare cannot verify that the correct passcode was entered except
on the model 1522 LLL Handheld Datalogger. If an incorrect passcode
was entered, LogWare continues and attempts to write the new settings,
however the thermometer will not accept the new settings.

e To close the Thermometer Settings dialog without writing the settings
back out to the thermometer, click the Cancel button.
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2.8

Saving thermometer and/or INFO-CON/probe
settings to a configuration file

LogWare provides a feature which allows many of the INFO-CON/probe set-
tings to be read in, viewed, modified and written back out to the thermometer.
These settings include:

e Probe serial number
e Probe wires
e Probe calibration and recalibration dates

e Probe conversion type and calibration coefficients
Viewing, modifying and writing the new settings to the thermometer:

e Select INFO-CON/Probe Settings from the Tools menu (see Section 8.3).

e The Select Model dialog is displayed (see Section 8.5). Select the ther-
mometer model from which the settings are to be read in. Also, select the
COM port to which the thermometer is connected and the baud rate to
use.

e Make sure LogWare can communicate with the thermometer by clicking
the Test Communication button.

e Click the OK button when communication is successful.

e All INFO-CON/probe settings are then read in and displayed in the Chan-
nel Settings dialog.

A Note: The controls for settings which do not apply to the selected ther-

mometer are disabled.

e Any of the settings can be modified at this time. All passcode protected
settings are indicated in RED. These settings can be modified freely but
will not be written back to the thermometer without the correct passcode
being entered when prompted.

e All INFO-CON/probe settings can be saved to a channel configuration
file by clicking the Save As button. To read in a channel configuration file
containing INFO-CON/probe settings, click the Open button. Channel
configuration files have a .CHN extension.

& Note: Channel configuration files are specific to each thermometer model.
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e To write any changes that have been made back out to the thermometer,
click the OK button. If any of the passcode protected settings were
changed, the Enter Passcode dialog is displayed (see Section 8.6). The
correct passcode MUST be entered in order for the new settings to be
properly written to the thermometer.

A Note: LogWare cannot verify that the correct passcode was entered except

on the model 1522 LLL Handheld Datalogger. If an incorrect passcode
was entered, LogWare continues and attempts to write the new settings,
however the thermometer will not accept the new settings.

e To close the Channel Settings dialog without writing the settings back out
to the thermometer, click the Cancel button.

Synchronizing the thermometer’s clock to the
computer

Most of the thermometers supported by LogWare have an internal clock.
LogWare provides a feature to synchronize the thermometer’s clock with the
clock on the computer.

Note: LogWare itself does not use the clock on the thermometer at all. All
dates and times associated with readings logged by LogWare use the cur-
rent date and time according to the computer’s clock.

Before synchronizing the thermometer’s clock, make sure the computer’s clock
is accurate. Use the Windows® Control Panel to adjust the date and time as
necessary.

Synchronizing the thermometer’s clock with the computer’s clock:

e Select Synchronize Date/Time from the Tools menu.

e The Select Model dialog is displayed (see Section 8.5). Select the appro-
priate thermometer model. Also, select the COM port to which the ther-
mometer is connected and the baud rate to use.

e Make sure LogWare can communicate with the thermometer by clicking
the Test Communication button.

e Click the OK button when communication is successful.

Note: If the date and/or time setting on the selected thermometer’s clock
is passcode protected, the Enter Passcode dialog is displayed (see Section
8.6). Enter the passcode and click the OK button to continue. If the
passcode is not known, click the Cancel button to abort setting the ther-
mometer’s clock.
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e LogWare attempts to set the thermometer’s clock to match the clock on
the computer.

A Note: LogWare cannot verify that the correct passcode was entered except
on the model 1522 LLL Handheld Datalogger. If an incorrect passcode
was entered, LogWare continues and attempts to write the new settings,
however the thermometer will not accept the new settings.

2.10 Importing logged data into a spreadsheet

The data logged by LogWare is saved into ASCII text files referred to as output
files. These files can be opened and graphed by LogWare by selecting the Open
Previously Logged Data File option from the View menu.

However, these files may also be imported into spreadsheet software such as
Microsoft® Excel for graphing or analysis.

Importing an output file into Excel:

A Note: This example uses Microsoft® Excel 2002. These steps may not ap-
ply if using a different version of Excel or another spreadsheet software
package.

e In Excel, select the Open option from the File menu to display the Open
dialog.

e In the Files of type box at the bottom of the open dialog, select the Text
Files option.

e Navigate to the folder where the output file is located. Select the output
file to open and click the Open button.
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e The Text Import Wizard — Step 1 of 3 dialog appears, Figure 9.

Text Import Wizard - Step 1 of 3 2| x|

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Mext, or choose the data type that best describes your data.

riginal data type
Choose the file type that best describes your data:
% Delimited - Characters such as commas or tabs separate each field.

" Fixed width - Fields are aligned in columns with spaces between each field.

Startimport at row: IB 5‘ File origin: I\":’indou\'s (AMSI) j

Preview of file T:\wbs\39340utput\Channel 1.txt.

= rs
T Peate Time Reading

8 |4ys03/20023 4:57:21 BEM 23.z00 °C

S |p4y703/2003 4:57:22 BEM 23.z00 °C

10 |n4/09/2003 4:57:23 BEM 23.z00 °C vI

=

Cancel I

Figure 9 Text Import Wizard — Step 1 of 3 dialog

e Make sure the Original data type option is set to Delimited. If the ther-
mometer and probe information is not needed, set the Start import at row
option to row 8 or the first row containing the logged readings. Set the
File Origin option to Windows (ANSI) and click the Next > button.
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e The Text Import Wizard — Step 2 of 3 dialog appears, Figure 11.

Text Import Wizard - Step 2 of 3

" This screen lets you set the delimiters your data contains. You can see
how your text is affected in the preview below.

Delimiters ) -
[V Treat consecutive delimiters as one
[V Tab ™ Semicolon ™ Comma
W Space [ Other: Text gualifier: i
Data preview
04/05/200% Ja- Ez.zo00 [C ﬂ
04/05/2003 J4:5 Ez.zo00 [C J
04/05/2003 J4:5 Ez.zo00 [C
04/05/2003 J4:5 Ez.zo00 [C
04/05/200% Ja- Ez.zo00 [C ﬂ
1 | ’
Cancel < Back | Einish

2%

Figure 11 Text Import Wizard — Step 2 of 3 dialog

e In the Delimiters box, select the Tab and Space options. Make sure the
Treat consecutive delimite